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BY ReEBEccA STILL

“I’m so afraid of the computer,”
said one student as she sat shaking in
front of the keyboard. She was
attending the first class in a new
course being offered at the library
called Computers for the Petrified.
She was hoping to learn to overcome
her fears of using the computer.

Local libraries in Olds and
Didsbury, Alberta had agreed to
partner with the community Literacy

Inside this Issue. ..

Recycled Computers................ 3
Software Reviews:
TEXTOYS wvvveereeerererersssesessinenns 3

Oxford Picture Dictionary ...... 4
Protea Picture Dictionary....... 4

Navigating the Web:

Lessons from the Land ............ 5
Lecon de la nature .................. 5
The Beehive ..., 6
Memphis City ..., 6
Canada Post ..., 6
Lesson Plans:

Cut, Copy and Paste................ 7
Indenting and Lists................... 7
Business Letters .......cccnnenne. 8
Word Processing 7-8 .......... 9,12
Handouts ..., 8-14
Technical Tips:

Buying a Computer IV ........... 15
ComingEvents: ........c......... 15
Ordering Information: .......... 16

Specialist in offering basic computer
classes. Literacy Specialists are part of
a two year project, Connecting
Literacy to Community, funded
through Bow Valley College and the
National Literacy Secretariat. Literacy
Specialists provide literacy awareness,
promotion and support to community
agencies, service providers and
businesses in six communities in
Alberta.

While working in the
community as a Literacy Specialist, a

Computer Classes for the Community

number of agency workers spoke to
me of the need for very simple, basic
computer instruction. They felt there
was a large audience who couldn’t
afford or even understand the many
computer classes that were being
offered in the community. Since I was
looking to provide a service to meet
the needs of the community, I decided
to follow up with the concept of
simple, basic computer classes.

Continued on Page

Computers in the Classroom
A Collaborative Approach

The recent launch of Ann
Haney’s book, Computers in the
Classroom, A Collaborative
Approach, has helped to fill a need
for computer resources written with
the adult literacy field in mind. The
book is an in-depth examination of an
approach to utilizing technology as a
tool in adult literacy education. As
the title suggests, Ann Haney’s
approach to technology is based on
the belief that adults are motivated to
learn when they are in control of their
learning and it directly relates to their
personal goals. The handbook
describes how to set up a program
that connects literacy learning with
real-life tasks and the computer skills
needed to complete them. It covers

everything from the theory behind
this approach to practical issues such
as layout of equipment.

The process outlined in the
book describes the background work
needed to ensure that a program
meets the needs of all the
stakeholders. Although the model
described tends to focus on designing
a program in a workplace setting,
most facets could be applied to a
variety of settings. This includes
resources such as a Curriculum Chart
that helps instructors to plan a course
that integrates a variety of literacy
and computer objectives.

The handbook includes sample
lessons and a CD of supporting files

Continued on Page




Computer Classes for the Community
Continued from Page 1

I designed a computer course to
help individuals in the community
who may face barriers to using the
computer due to low literacy levels.
The course is two hours a week for
eight weeks and focuses on a few
main concepts such as formatting and
editing text, saving a document,
opening a document and printing. It
also covers opening and closing
programs, understanding the keyboard
and mouse skills. The concepts are
broken down into easy to manage
tasks with lots of practice. [ use a
variety of articles or recipes, which
are short and simple. Each week the
class receives a new article to type
into the computer. They learn to type,
edit, format, save and print the article.
I also created handouts using plain
language, that explain step by detailed
step how to do the tasks. One student
stated the part that was most useful in
the program was that “a person could
understand in people words what you
were learning.” Another student
stated, “The detailed instructional
pages are good to jog my memory as |
do it at home.”

I have discovered that class
members need the opportunity to
repeat over and over again the same
concepts. One participant remarked
that repeating things over and over
again helped to form a habit. He said
at his age he learns very slowly. He is
93 years old.

The lesson plan handouts in the
recent CONNECT issues have been
very useful. I especially like the
lesson on editing text and spacing in
Volume 5, Issue 2, pages 8 and 9. 1
downloaded the two recipes onto
disks and had each student make the
changes as directed. The students
didn’t save the changes onto their disk
and could then go back to the exercise
and repeat it as often as they liked.

The libraries were a logical
partnership choice in offering the
course since they have a number of
computers that are available for
community use. As well, the library
staff are often called upon to assist
patrons on the computers. “This
partnership fulfills some of the
demand for instruction that would
otherwise fall to staff,” stated one
librarian.

The first time the course was
offered it was advertised through the
local community learning
opportunities calendar. A few
individuals were directed to the course
with the help of library staff. The
course was so well received that the
next session was full with a long
waiting list for another session.

One library board felt the need
to remove all barriers for students
taking the class and waived the
nominal course fee. Although there
has been funding to offer the course
for only one year, at this time, the
library is willing to find other funds to
continue to offer the course. They felt
the course added a valuable “service
to their library and filled a gap in
skills for people who needed (wanted)
access to technology.”

The course only helps people get
started on the computer but after the
course many students felt comfortable
taking other computer classes. Some
even felt comfortable enough to teach
someone else the skills they had
learned. Many of the students felt
confident enough to experiment and
expand their skills. One student said
she felt she actually learned
something and was willing to try more
as a result of the course. Another
student said, “I now feel confident in
experimenting with new areas.” One
librarian commented that “students are
all expressing confidence and a sense

I even learned a few things. It’s
important to provide lots of practice
for each skill learned and not to give
too much information at once. It’s
important to present material in small
“bytes”.

As for the student who was
scared stiff, she said at the end of the
course, “I feel more at ease. I'm
convinced that I can’t break or
damage anything.”

Rebecca Still is the Coordinator
for the adult literacy program, Project
Read Soon, Mountain View Society in
Mountain View County, Alberta. She
has also been a Literacy Specialist for
the past two years. For more
information on the computer course
contact Rebecca at 403-556-3045 or
e-mail: rebecca_still@elit.ca

Computers in the Classroom
Continued from Page 1

that were used in a pilot project at
the Learning Experience Centre of
the Union of Needletrades
Industrial and Textile Employees,
at Phillips and Temro Industries
and Palliser Furniture in Winnipeg,
Manitoba. The publication was
funded by the National Literacy
Secretariat and can be purchased
from Grass Roots Press,
1-888-303-3213,
www.literacyservices.com.

This helped them to strengthen their of accomplishment.”
skills in editing.
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Looking for Recycled Computer Equipment?

by Diane McCargar

For those of you who may not
have the budget for new computer
equipment, there are lots of options
available to you. Before you rule out
new equipment, investigate whether
you are eligible for educational or
non-profit discounts. Many of the
larger hardware and software
companies offer these types of
discounts. If new is definitely out of

reach, consider looking for “gently
used” equipment. As Tanya Clary-
Vandergaag indicated in her article in
the last issue of CONNECT, many
large companies upgrade computer
equipment on a regular basis. What is
out-of-date to them may be just fine
for your purposes. When you accept
donations like this, keep in mind that
the equipment may require a lot of
setup before it is ready for you to use.
There are government and non-profit

programs that will do this work for
you. Computers for Schools (http.//
cfs-ope.ic.gc.ca/) is a federal program
that collects computers and donates
them to schools, libraries and
provincial/territorial employment and
training programs across Canada.
Reboot Canada (http://reboot.on.ca) is
a non-profit organization that
refurbishes computer equipment and
distributes it to charitable
organizations.

TexToys

Creating Online Exercises

TexToys is a collection of two
authoring programs: WebRhubarb and
WebSequitur. Both programs allow
the creation of web-based exercises
based on text entered by the instructor.

WebRhubarb exercises require
learners to reconstruct a text word by
word. The words in the text are
hidden and then uncovered as the
students type them. If the learner
types the wrong word or spells a word
incorrectly it is collected in a list of
incorrect words. Learners can receive
hints if necessary.

WebSequitur breaks a text into
segments of equal length and asks
students to reorder these segments.

Creating these exercises is very
simple. Instructors type a text and

then export it in a webpage format.
The exercises can then be used offline
or uploaded to a server,
hotpotatoes.net, for access online.
The offline version can be viewed
without a connection to the Internet
but your computer must have an
Internet browser such as Netscape.
The online version can be accessed
on any computer which has an
Internet connection.

A shareware version of this
software can be downloaded from
http://www.cict.co.uk/software/
textoys/index.htm. The shareware
version restricts you to short exercises
and doesn’t allow you to upload your
exercises to the Internet.

by Diane McCargar

Just the facts

Theme: Authoring Online Exercises
User Level: Beginner to Advanced

System Requirements:
Windows 95, 98, NT4, 2000 or XP
2 MB Hard Disk space,

Netscape 3 and higher or
Internet Explorer 4 and higher

Cost:

Single-User $32.80 US
Multiple-user pricing available
Pricing is per author/instructor

Ordering:

Creative Technology
http://www.cict.co.uk/software/
textoys/index.htm
enquiries@cict.co.uk

by Elyse Schwartz

It is often difficult to find
software suited to the adult beginning
reader. Most programs that teach
reading and writing skills assume that
some level of literacy has been
achieved. The best place to find

simple, familiar words is in a picture
dictionary. A software dictionary has
the advantage of audio as well as
visual cues, and the learner can
practise computer skills, particularly

mouse manipulation. In this issue, we

have chosen to focus on two
interactive picture dictionaries: The
Oxford Interactive Picture
Dictionary and The Protea
Interactive Picture Dictionary.
Reviews of each appear on Page 4.
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by Elyse Schwartz

The Oxford Interactive
Picture Dictionary

The Oxford Interactive Picture
Dictionary CD is based on the book of
the same name. The CD gives the
meaning and pronunciation of 3,700
words using images and voices in
American English. In addition to the
dictionary component, the software
has a wide range of activities that
could be useful for more advanced
learners as well as beginners.

The main menu consists of
twelve units that are divided into a
number of topics. When a topic has
been selected, a detailed picture
appears on the screen. Learners can
see and hear a word or phrase
corresponding to any part of the
picture. There are a number of
activities that go with each topic. The
basic activities consist of identifying
the correct picture or typing the word
or phrase correctly in response to a
visual or spoken prompt. Each topic
has a test, and the learner’s progress
can be monitored. There’s a
Flashcard Maker where the learner
can practise the vocabulary with on-
screen flash cards. A couple of games

keep the practice from getting
monotonous. One simulates a game
show where the learner gets points
according to the difficulty of the
question, and another is a countdown
where the learner has to answer all the
questions in a certain number of
seconds. There are some good
reading and writing activities for more
advanced learners which incorporate
the vocabulary of each topic. Some
topics have a short text, such as a
memo or an interview. There are
activities accompanying these texts,
such as cloze, dictation, and a writing
assignment patterned after the text
with hints for useful phrases.

Learners can access a dictionary while
writing. They can choose only the
current topic, all words, or their own
list.

Although the Oxford Interactive
Picture Dictionary is somewhat
expensive, there are so many activities
and the material is presented in such a
practical, user-friendly manner that
this software seems well worth the
price.

The Protea Interactive
Picture Dictionary

The Interactive Picture
Dictionary, which is distributed by
AlphaPlus, is produced by Protea
Textware in Australia. It contains
over 800 key words which are
arranged in six main groups with
several topics each. The words for
each topic are listed in alphabetical
order on the left side of the screen.
When the learner clicks on a word in

the list, the word is spoken and a
visual image appears. To provide
context, a sentence containing the
word appears on the screen. The
sentence can also be spoken. The
voices are Australian, although there
may be a North American version
available in the future. Each word has
accompanying activities which consist
of typing missing letters, typing the

Just the facts

The Oxford Interactive
Picture Dicationary
Theme: Picture Dictionary
User Level:
Beginner to Advanced
System Requirements:
Windows 95, 98, 2000, XP or NT
16 MB of RAM
10 MB of Hard Disk space
SVGA, 640 x 480, 256-colour mode
Macintosh 68040,
Power Mac 0S 7.5.3,
15 MB of Hard Disk space
Cost:
$175 CDN for a single user
Ordering:
Oxford University Press
http://www.oup.com/ca
1-800-387-8020

The Protea Interactive
Picture Dicationary
Theme: Picture Dictionary
User Level:
Beginner to Intermediate
System Requirements:
Windows 3.1, 95, 98, 2000, Me, XP
256 colour display
10 MB of Hard Disk space
Cost:
$140 CDN for a single user
Ordering:
AlphaPlus Centre
1-800-788-1120, Ext. 117
http://alphaplus.ca

word from memory or typing the
word in a sentence. There are
spelling and vocabulary tests for each
topic. A special section for verbs
shows the simple present, simple past
and present continuous forms. For
beginning learners who need a lot of
repetition and want to work on their
spelling, this software would be
excellent.

CONNECT

4

Volume 5, Issue 4


http://alphaplus.ca
http://www.oup.com/ca

Lessons From the Land
is an interactive, multimedia
website which takes visitors
on a virtual journey of the
Northwest Territories’
traditional Aboriginal Idaa
Trail. It is presented in
English, French or Dogrib. The
site is organized into two (
different levels of activities. i

First, learners can browse _w\
photos, videos and audio clips
to explore the historical and
cultural significance of eight
locations on the Idaa Trail.
The factual text accompanying each photo is well-written,
and about two to four sentences in length. The texts
highlight points of interest or describe geographic
phenomena. Audio pronunciation is provided for
highlighted vocabulary. The video clips are under a minute
long and have Dogrib audio with English subtitles. One
page has a timeline presented as a two-column table. The
pages are uncluttered and easy to use. As well, a resource
list of website links and related videos, books and articles
is provided.

Secondly, learners can travel the trail with a modern
day Dogrib family in an online “storybook”. The
storybook includes audio and visual support for the text, a
few simple activities, along with a teacher’s guide. The
content is presented as fiction, with drawings instead of
photos, on 55 pages divided into nine chapters. Although
this section of the site is entered via a “Hey Kids” title, the
story is not juvenile in content.

Overall, the website is user friendly for both learner
and instructor and provides interesting large print texts
with visual and audio support. There are certainly
opportunities for developing research skills, reading
comprehension, and creative writing. New Internet users
are likely to find moving from page to page, enlarging
images, and clicking on highlighted words to be a
pleasurable experience, with little chance for confusion or
frustration.

Lecons de la nature est un site Web
interactif, multimédia qui emmeéne les visiteurs
sur un voyage virtuel le long de la route Idaa,
route traditionnelle des autochtones aux
Territoires du Nord-Ouest. Le site est présenté
en anglais, en frangais ou en dogrib.

D’abord, les apprenants peuvent examiner
des photos ainsi que des clips vidéo et audio
pour explorer la signification historique et
culturelle de huit lieux le long de la route Idaa.
Le texte factuel accompagnant chaque photo
est bien écrit et consiste d’environ deux a
quatre phrases. Le texte met en évidence les
points d’intérét ou décrit des phénoménes géographiques.
La prononciation audio est disponible pour du vocabulaire
mis en évidence. Les clips vidéo ont une durée inférieure a
une minute et sont en dogrib avec sous-titres anglais. Une
page fait présenter une ligne de temps sous forme de table
a deux colonnes. Les pages sont non encombrées et faciles
a utiliser. De plus, on fournit une liste de ressources
comprenant des liens de site Web, des vidéos, des livres et
des articles.

Ensuite, les apprenants peuvent suivre la route avec
une famille dogrib moderne dans un récit en ligne. Le récit
comprend des appuis audio et vidéo pour le texte, quelques
activités simples et un guide de ’enseignant. Le contenu
est présenté comme fictif, avec des illustrations au lieu de
photos, sur 55 pages réparties en neuf chapitres. Malgré le
titre ‘Les enfants’ qui donne accés a cette partie du site, le
contenu du récit n’est pas juvénile.

En général, le site Web est facile a utiliser tant pour
I’apprenant que pour I’instructeur et fournit des textes
intéressants en gros caractéres avec un appui visuel. La
partie audio est facultative. Il y a certainement des
possibilités pour développer les habiletés de recherche, la
compréhension de texte et la création littéraire. Les
nouveaux utilisateurs d’Internet vont probablement trouver
le déplacement de page en page, I’agrandissement des
images et le déclic sur des mots mis en évidence une
expérience agréable, avec peu de chance de confusion ou
de frustration.
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The Beehive is an information
resource provided by the One
Economy Corporation, a nonprofit
organization based in Washington,
D.C. The Beehive focuses on life
events, and gives basic information on
topics such as money, health, jobs,
school and family. Some of the
specific information is applicable only
in the U.S., but there is a great deal of
general information that could be
useful to Canadian literacy
practitioners and learners. Headings
make it easy to select the subtopic of
interest. The explanations are clear
and use simple language, and there’s
an option to make the screen text
larger. Some sections have games and
quizzes. The topics I have chosen to
focus on are money and jobs.

The Money section provides
elementary banking information such
as how to get a chequing account and
how to write cheques and use an ATM
card. ATM machines can be
intimidating, especially to those with
literacy issues. There is an excellent
demonstration, with step-by-step
instructions accompanying each
screen of a virtual ATM. Another
topic is Budget Basics, where the user
is able to create an on-screen budget.
There are tips and advice, as well as
instructions about what information to
put in each box. When completed, the
budget can be printed. There is
detailed information about how to fill
out tax forms, but some of the
information wouldn’t apply to
Canadian tax returns.

The Jobs section gives
information on how to write an
effective cover letter and resume.
There are tips on how to have a good

theWe

interview, how to provide references,
and a sample thank-you letter. The
section on Planning a Career is
excellent. There is a link to a site
called CareerKey, which has an online
questionnaire. By identifying
interests, abilities and personality
traits, the user can see which types of
jobs he or she would be suited for.
Another link to CareerZone provides
detailed information about many
kinds of jobs.

Because of the variety of useful
information which is presented in a
well-organized manner, the Beehive is
definitely worth exploring as a
literacy resource.

Teachers wanting to upgrade
their computer skills in order to better
integrate computer activities into their
curriculum should investigate the
online Professional Development
material designed for Mempbhis City
Schools. This site contains online
computer modules utilizing software
such as Windows, the Mac Operating
System, Word, Excel, PowerPoint and
the Internet. Instructors learn
computer skills while completing
computer tasks related directly or
indirectly to the classroom
environment. Instruction in the
computer skills required to complete
the tasks is available through links.
This layout allows instructors to
progress through the material
sequentially or focus only on their
weaknesses. Some of the modules
make use of material from a third
party, Internet 4 Classrooms. This

layout can make the sequence of the
modules difficult to follow at times.
Generally the material from both sites
is simply written and contains lots of
graphics, many of which could be
used with learners. The modules are
available to teachers as self-paced
professional development activities.
Each module comes with assessment
forms that can be used to document
achievement.

The Canada Post website has
potential to provide authentic Internet
activities. This site contains a variety
of resources that could be used for
practice with writing addresses and
basic math skills. The site includes a
Postal Outlet Guide and Postal Code
Look-up and Rate Calculation tools.
An instructor could develop a short
game in which learners must find the
postal codes for several addresses.
Learners could use this information to
practise typing addresses correctly and
submitting forms. Learners could also
measure envelopes and packages and
then enter that information to
determine the cost of mailing the
items. There is also a section on “tips”
for sending mail economically.
Learners could examine the
information and
then decide the
best way to send
different
groupings of
mail such as
flyers, business
letters, coupons,
and/or
newsletters.
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__Lesson Plans | s he Literacy Lab

The following lessons cover word processing skills such as cut, copy and paste, indenting, and typing lists. Word
processing skill sheets have been provided for each of these skills and can be given to learners to use when needed. We
have chosen to teach cut, copy and paste using the Edit menu because this menu is common to many different types of
software programs. We have chosen to teach indenting using the Ruler. If the Ruler isn’t visible you can make it visible
in the View menu. For indenting and lists, we have chosen NOT to use the AutoFormat features in Word because we
have found they cause considerable frustration overall. You can turn off these features by going to the Format Menu
and choosing AutoFormat then Options. Drag-and-drop is also a feature that [ recommend you turn off when working
with beginners. You can turn this off by going to the Tools menu and choosing Preferences and Editing.

Lesson 14

Cut, Copy and Paste by Liz Devries*

Computer Objective 14-1: Learners will be able to copy and paste. 14-2: Learners will be able to cut and paste.
Literacy Objective: Learners will be able to scan for details in informational text and select relevant details for
categorizing information.

Materials: Word Processing 7 skill sheet, Lesson 14 - Handout 1 and Lesson 14 - Handout 2 to be downloaded from
http://www.nald.ca/connect.htm. Learners also need information sheets on immunization schedules for infants and
children which can be obtained from local Public Health Departments or from Attp.//ottawa.ca/city services/yourhealth/
healthylife/immune_child en.shtml. As well, learners will require information sheets on recycling practices, preferably
from their own community. If these are not available, blue box and black box recycling information is available from this
site: http.//ottawa.ca/gc/recycling en.shtml

Introduction: Discuss the topics of immunization and recycling to make sure learners are familiar with the ideas
associated with these concepts. The two skills of copy and paste and cut and paste are extremely useful when editing and
formatting. Learners should clearly understand the difference between the two procedures. Some learners may require a
concrete demonstration of this.

Procedure: Before beginning the lesson, have learners type their name. Then have them copy and paste their name two
times, placing the copied name under the previous name so that there will be a vertical list of three identical names. Then,
have them type their address, phone number and age on subsequent lines. Next have them practise cut and paste to place
each of these three pieces of information next to their names above.

Now, give the learners a hard copy of an immunization schedule and have them open Lesson 14 - Handout 1 as a
document on their computer. The handout contains a short description of common diseases that require immunization.
Have learners copy the names of the diseases (not the descriptions) and paste them next to ages for immunization as
indicated in the schedule.

To practise cut and paste, learners need a hard copy of a recycling information sheet and Lesson 14 - Handout 2 as a
document on their computer. Ask them to cut and paste each item into the appropriate category (Blue Box, Black Box,
Cannot Recycle) as described in the recycling information sheet.

* Thanks to Michele Merkley for the idea behind the recycling handout.

Lesson 15

Indenting and Lists by Elyse Schwartz

Computer Objectives 15-1: Learners will be able to set first-line, hanging, left and right indents using the Ruler.

15-2: Learners will be able to type a bulleted list using the Formatting Toolbar.

Literacy Objective: Learners will read informational text about health issues.

Materials: Word Processing 8 skill sheet, Lesson 15 - Handout 1 and Lesson 15 - Handout 2.

Introduction: Although indents can also be set by using Format, Paragraph, we have chosen to use the Ruler because it’s
simpler and more straightforward. Numbered lists can be done using the Formatting Toolbar, but this is hard to control
and can be very frustrating. It is suggested that the automatic numbering feature be turned off for this lesson. You can
turn this off by going to the Format Menu, choosing AutoFormat, Options and then AutoFormat As You Type.
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Bulleted lists are easy to do using the Formatting Toolbar. Hitting the Enter key twice or clicking on the Bullet button
will return the text to the left margin and eliminate the hanging indent.
Procedure: Before beginning this lesson, have the learners practise using the Ruler to make indents. Show them that to
make a left indent, the mouse pointer must be on the rectangle below the triangular markers so that both triangles move
together when they are dragged to the desired location on the ruler. To make a hanging indent, the arrow must be on the
bottom triangle so that only this triangle moves. For a first-line indent, the arrow must be on the top triangle. A right
indent is easy to make since there is only one marker. Give each learner a copy of Lesson 15 - Handout 1. Ask them to
type the text, using a first-line indent for the paragraphs, left and right indents for the quotation, and a hanging indent for
the numbered list.

Next, show the learners the Bullet button on the Formatting Toolbar. Have them practise turning the bullets off and on
and watch how the Ruler changes to make the indents. Give each learner a copy of Lesson 15 - Handout 2. Ask them to
type the text.

Lesson 16
Business Letters by Diane McCargar

Computer Objective: Learners will be able to type a business letter using the correct format.
Literacy Objective: Learners will be able to write a simple complaint letter.
Materials: Lesson 16 — Handout 1
Introduction: There are a handful of circumstances where someone might need to write a business letter. A complaint
letter is one of the more common situations. (We can all think of something we’d like to complain about.) For this lesson
we’ve chosen to show an example of a block style business letter. This is the easiest and most common format used
today.
Procedure: In this lesson learners will write and type a simple complaint letter to a landlord. Provide students with the
sample complaint letter shown in Lesson 16 - Handout 1. Discuss the parts of the letter and the format. Provide each
student with a household problem and the contact information of a fictitious landlord. For example,

Household Problem: The hot water tap in my bathroom is dripping.

Landlord: Frank Moore, Minto Apartments, 440 Albert St., Ottawa, Ontario, K2T 1V0
Ask your students to type a complaint letter using the information you give them.

Lesson 15 - Handout 2

Type the text below. Use the Bullet button on the Formatting Toolbar.

What can we do to prevent West Nile infection?

Avoid mosquito bites.
» Apply insect repellent to exposed skin when you go outdoors. Be careful putting
repellent on children. Don’t put it on their hands and avoid their mouths and eyes.
» Wear protective clothing such as long sleeves, long pants, and socks while outdoors.
» Spray clothing with repellents containing DEET or permethrin.
* Try to stay indoors between dusk and dawn.
» Avoid activities in areas where there are many mosquitoes.
» Fix or install window and door screens to keep mosquitoes out of buildings.

Always read and follow the product directions when using any insect repellent or insecticide!

CONNECT 8 Volume 5, Issue 4



Word Processing 7 BOUTMELTAAET TN EEI(C

Standard Toolbar

Cut Copy Paste
/

~_ /
PRS0 o

%D@EE.EHqT 0% = (2,

DEeEe SR Y

Copy and Paste

2 Edit ¥iew Insert Format Tools

l . H ig h I ig ht teXt- ¥7 Undo Crop Picture  Ctrl+2
10 Ganit Beneat GEr] £
% 1 s iy
._% 2 Bt ctic [Edic wew Insert Format Tools
3. CO py IRl SJ:'BCia""_ 3 Undo Move Object Chrl4Z
Faste a5 Hyperlint
. ¥ Cant Hepeat g
4. B where you want it. - -
- Epy, G|
! ' Paste Special...
Paste asHyperinl
6. B Paste.

Cut and Paste

1 H 2 ’E Wiew Insert Format Too
1. Highlight text. e s
\% - 1S Repeat Typing  Chrl+Y
2. Edit. 3
Copy Chrl+C
3. \% CUt E,Easte Chrl+Yy 5 lﬁ Yiew Insert Format Tools
Paste Special... =7 Undo Move Object  Ctr+Z
4. B where you want it. Pz es Hpein e« oo
| Gt G
: a ke
5. Y} Edit. 6 [ :
Paste Special. ..
6 \® Paste Paste asHypeinl

Lesson 14 - Handout 1 &R EE]

Instructions:

immunization.

1. Read about the diseases on this handout.
2. Look at the immunization schedule given to you by your instructor.
3. Copy the name of each disease and paste it beside the age that requires this

4. Add a comma and a space after each disease you paste. For example,
2 months — DIPTHERIA, POLIO, HIB, PERTUSSIS, TETANUS
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Immunization can protect a child from the serious diseases described here. For detailed information check
with your doctor.

DIPTHERIA —This is a very serious infection that can cause breathing problems, heart failure, paralysis and
death.

HEPATITIS B - This is a virus that can cause serious liver problems.
POLIO myelitis — This is a virus that can cause paralysis and death.

HIB (Haemophilus B) — This is a bacteria that can infect any part of the body. The infection can lead to severe
joint problems, pneumonia, brain damage and even death.

MEASLES — This disease causes rash, high fever, cough, runny nose and watery eyes. It can cause ear
infections, pneumonia, hearing loss, brain damage and even death.

MUMPS — This disease causes fever, headache and painful swelling of the glands in the mouth and neck.

PERTUSSIS - This is also called whooping cough. It causes severe coughing for weeks or months. The risk
of complications is greatest in children under seven.

TETANUS - This is also called lockjaw. It causes painful muscle spasms, breathing failure and even death.

RUBELLA - This is also called German Measles. It causes fever, rash, swelling of the neck and painful joints.
If a pregnant woman gets rubella, it is very dangerous for the unborn baby.

IMMUNIZATION SCHEDULE
2 months —
4 months —
6 months —
12 months —
18 months —
4 to 6 years —
14 to 16 years —

Every 10 years —
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Instructions:

1. Look at the items written below.

2. Look at the information your instructor gives you about recycling.
3. Cut and paste each item into the correct box.

glass bottles newspapers
milk bags pop cans
jar lids tin cans
light bulbs pots and pans
waxed paper pizza boxes
cereal boxes chip bags
toilet paper rolls books
plastic bags pottery
foil aluminum pie plates
gift wrap shoe boxes
magazines telephone books
cardboard flyers

BLUE BOX BLACK BOX CANNOT RECYCLE
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Indenting and Lists

Rul

First-line Indent Marker

ER EEENERE RN R R RN NEEREREE

Second-line Indent Marker

Left Indent Marker

First-Line Indent

\

=

Right Indent Marker

] B 7 e s 2
1. Drag First-Line Indent Marker to right.
2.
Hanging Indent (Numbered Lists)
[x] s =
1
1. Drag Second-Line Indent Marker to right.
2. (& number.
3. PressTab.
4,
Left and Right Indents
(O R (R R KRR KRN KA P AR " R |
1 2

1. Drag Left Indent Marker to right.
2. Drag Right Indent Marker to left.

3. &

Indent After Typing

1. &

2. Highlight.
3. Drag Indent Markers.
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Lesson 15 - Handout 1

Indenting and Lists

Instructions:

1. Type the text below.

2. Make a 0.5”first-line indent for the first two paragraphs.

3. Make aleftindent at 1.5”and a right indent at 4.5”to type the quotation.
4. Make a 0.5”hanging indent to type the numbered list.

Handwashing Keeps the Germs Away

The most important thing you can do to keep from getting sick is to

wash your hands.

By frequently washing your hands you wash away germs that you

have picked up from other people, or from contaminated surfaces, or from
animals and animal waste.

“An ounce of prevention is worth a
pound of cure!”

Here is the correct way to wash your hands:

l.

2.

Use soap and warm running water.
Rub your hands vigorously for at least 20 seconds.

Wash all surfaces including the backs of your hands, wrists, between
fingers, under fingernails.

Rinse well. Leaving soap on your hands will lead to drying and
cracking of your skin.

Dry your hands well with a paper towel.
Turn off the tap with the paper towel you used to dry your hands. This

prevents picking up the germs that were on your hands when you
turned on the tap.

* See Page 8 for Lesson 15 - Handout 2
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Lesson 16 - Handout 1 B G (ke M i o

Instructions:

1. Read the sample complaint letter.
2. Read the household problem and landlord information given to you by your teacher.
3. Type a complaint letter about your household problem.

Return, Rachel Greene
Address| 1203 - 440 Albert Street
(From:)| Ottawa, Ontario
K2T 1VO0 2-6 Enters
Date| May 23, 2003 6 Enters
Inside, Frank Moore
Address| Minto Apartments
(To:)| 1B —440 Albert Street
Ottawa, Ontario
K2T 1V0 2 Enters
Greeting| Dear Mr. Moore: 2 Enters
| am writing to you because the hot water tap in my bathroom is dripping. | mentioned this
Body| tothe superintendent on Monday, May 12, 2003 and he said he would fix it that week. It is
almost two weeks later and it still hasn’t been fixed. Itisn’t a big problem but the wasted
hot water is costing me money on my heating and water bills. 2 Enters
| would appreciate it if you could speak to the superintendent about this problem. I'd like to
know when the problem will be fixed. 2 Enters
Closing ~Sincerely, 6 Enters
Signature
Name| Rachel Greene
CONNECT 14 Volume 5, Issue 4



Technical Tips

Buying a New Computer - Part IV by Diane McCargar

Before thinking about peripherals, you have to consider how you are going to connect them to your computer. The
places where you connect devices such as printers to your computer are called “ports”. In the past, the myriad of ports, of
different shapes and sizes, has caused great frustration to new computer users. The labeling or lack thereof didn’t help the
situation any. There have been some improvements in this area that hopefully will make the task of setting up a computer
less frightening.

Older ports such as PS/2, parallel, and serial are being replaced by multipurpose USB and FireWire ports. You still
see PS/2, parallel and serial ports on new computers, but they are becoming obsolete. Parallel ports are long, thin ports
that were used for connecting printers and external storage devices such as CD drives to your computer. Serial ports are
smaller and were used for connecting modems and mice. PS/2 ports are the small, round, 6 pin ports used for connecting
keyboards and mice.

USB and FireWire ports have several advantages over these older ports. “Plug and play” and “hot plugging” are the
obvious ones. In the past, if you wanted to connect a peripheral to your computer you had to turn the computer off, plug
in the device and then turn the computer on. Hot plugging means you can plug in a device while the computer is on and
the computer should recognize it right away. Plug and play implies that you don’t have to do any setup to use a new
peripheral. You can forget about port numbers and IRQ settings, etc. Speed is another advantage. Firewire, sometimes
referred to as IEEE 1394 or iLink, had the fastest data transfer rate until the recent introduction of the new USB 2.0 port.
The USB 2.0 format is as fast, if not faster, than FireWire and many times faster than its predecessor USB 1.0. USB and
FireWire ports also have their own power supply. This means devices like modems and speakers no longer need AC
power adapters; they draw the power they need from the port itself.

Before the upgrade in USB technology, it was recommended that peripherals that required high speed connections
such as hard drives, DVD drives, camcorders, digital cameras, printers, and scanners use FireWire. USB ports were
mainly being used for devices that didn’t require high speed such as keyboards, mice, low-resolution digital cameras and
modems. USB 2.0 has now allowed for the use of USB ports with most peripherals, with the exception of digital video.
FireWire still has a strong hold on this market. Both Firewire and USB ports are small and rectangular in shape.

There is one other high speed port that I haven’t mentioned and that is SCSI. Up until recently it has been a standard
on all Macintosh computers.

Connecting a computer to a network or the Internet requires a special port. For a regular (slow) dial-up connection
to the Internet you need a regular modem port. For a high-speed connection to the Internet you need an Ethernet port.
Both of these ports look like a regular phone jack but the Ethernet port is slightly larger. Most businesses use Ethernet
ports to connect their computers to local area networks.

Another small improvement we’ve seen lately is the location of ports. How often have you tried to plug something
into the back of a computer without really being able to see what you were doing? New PCs are now coming out with
ports on the front of the computer for easy access.

Finally, if you are trying to connect a peripheral to your computer and your computer doesn’t have the appropriate
port then you have a couple of options. In some cases, you can buy adapter cables. Otherwise, you will need to look into
buying an adapter card for your computer. The motherboard of your computer should have unused slots where you can
insert a card. The end of the card will be visible, usually at the back of the computer and contain the ports that you
require. There are two different kinds of slots on a motherboard. ISA is an older format. PCI is the current standard. You
should know what type of slots are available in your computer before you buy cards such as a modem or SCSI cards.

AAAAA ‘L

\= | Current Events

National Educational Computing Conference (NECC 2003)
The International Society for Technology in Education (ISTE) is having their annual conference from June 29th
to July 2, 2003 in Seattle, Washington. For more information visit: http://neccsite.org
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CONNECT Order Form

You can purchase the five issues that make up Volume 5 of CONNECT at a cost of $10.00. This nominal fee
helps to offset some of our distribution costs. Non-profit literacy organizations may request a free copy of
CONNECT which can be freely photocopied for use within literacy programs. Issues of CONNECT can also be
accessed through the NALD website at: http://www.nald.ca/connect. htm

To order CONNECT, enclose a cheque payable to the Ottawa-Carleton District School Board with your order
form and mail it to CONNECT, c¢/o Diane McCargar, Ottawa-Carleton District School Board, 440 Albert St.,
Ottawa, Ontario, KIR 5B5. Orders can also be faxed to 613-239-2324.

CONNECT - Volume 5 (5 Issues) @ $10.00 $
Back Issues of CONNECT - Volume @ $10.00 $
Total:  $

Names of Recipients:

Name of Organization:

Type of Organization:

Mailing Address:

Phone: Fax: E-mail:

We welcome submissions on the following topics

Reviews: Lesson Plans:

Write a review of a software program Describe a lesson or activity that

or Internet site. you have used successfully in your
program.

Reports From Learners:

Have students write about their Reports From the Field:

experiences using computers, and why Describe how computer

they think computers are useful in technology is used in your

literacy programs. program.

PHONE: 1-613-239-2583 FAX: 1-613-239-2324 E-MAIL: connect@ocdsb.edu.on.ca
Editor: Diane McCargar  Assistant Editors: Elyse Schwartz and Liz Devries
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